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Introduction to Circuit
Envelope Simulation

• “Product Description” on page 1-2

• “Minimize Computations for RF Simulations” on page 1-3

• “Using SimRF Software for the First Time” on page 1-11



1 Introduction to Circuit Envelope Simulation

Product Description
Design and simulate RF systems

SimRF™ provides a component library and simulation engine for designing
RF systems. It includes amplifiers, mixers, S-parameter blocks, and other
basic blocks for designing architectures for wireless transceivers used in
communication and radar systems. You can connect these blocks arbitrarily
to form diverse architectures and to simulate the behavior of the RF front-end
at the system level.

SimRF lets you simulate RF amplifiers to estimate gain, noise, even-order,
and odd-order intermodulation distortion. The simulation of mixers enables
you to predict image rejection, reciprocal mixing, local oscillator phase offsets,
and DC conversion. You can also simulate frequency-dependent mismatches
between linear and non-linear components in the time and frequency domains.

With SimRF you can model RF systems at different levels of abstraction.
The circuit envelope solver enables high-fidelity, multi-carrier simulation of
networks with arbitrary topologies. The equivalent baseband library enables
fast, discrete-time simulation of single-carrier cascaded systems.

Key Features

• Circuit envelope solver for multiple carrier-frequency simulation

• Arbitrary network descriptions, enabling N-port block modeling and
intra-model signal probing

• S-parameter data files for time-domain and frequency-domain simulations

• Passive components, including resistors, capacitors, inductors,
transmission lines, and general impedance blocks

• 3-port mixer and 2-port amplifier models specified by noise figure, IP2,
IP3, P1dB, and Psat

• Equivalent baseband library for discrete-time simulation of single-carrier
cascaded systems
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Minimize Computations for RF Simulations

Minimize Computations for RF Simulations

In this section...

“Simulate a Passband Signal in Simulink Software” on page 1-4

“Compare Passband and Baseband Signals in SimRF Software” on page 1-5

“Simulate the Envelope of a Baseband Signal” on page 1-8

This example shows how to use circuit-envelope simulation to reduce the
number of time steps required to simulate a simple signal by a factor of 100.

Traditional methods of circuit simulation are not ideal for RF systems. In
Simulink®, simulating signals with high-frequency components requires
choosing a proportionately small time step. However, the envelope of such
signals often varies on a much larger time scale. The SimRF circuit-envelope
environment takes advantage of this condition in order to model RF signals
accurately, while also reducing simulation time.

The following figure illustrates a signal x(t) for which circuit-envelope
simulation is ideal:

The signal consists of a time-varying modulating signal on a high-frequency
carrier. In many RF applications, the frequency of the modulating signal A(t)
is much less than the frequency of the carrier, fc.

SimRF software handles the carrier cos(2πfct) analytically, so it only needs
to simulate the modulating signal. The redefined system that the software
uses is mathematically equivalent to the original. However, by taking time
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1 Introduction to Circuit Envelope Simulation

steps on the scale of the modulating signal instead of the carrier, the software
produces equivalent results in less time.

Simulate a Passband Signal in Simulink Software
The model

ex_simrf_tut_passband

simulates a 1-GHz sine wave using fundamental Simulink blocks. This
section of the example shows you how to modulate a real passband signal with
in-phase and quadrature components.

The system specifies a real passband signal x(t) according to the formula

x t I t f t Q t f tc c( ) ( ) cos ( )sin     2 2 

where:

• I(t) is the in-phase part of the modulating signal, equal to 3 in this example,
modeled by the Constant block labeled In-phase modulation.

• Q(t) is the quadrature part of the modulating, equal to 4 in this example,
modeled by the Constant block labeled Quadrature modulation.

• fc is the carrier frequency, equal to 1 GHz in this example.

Running the model produces the following output on the scope.
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Minimize Computations for RF Simulations

The output signal at the Real Passband Scope has a magnitude of 5 and a
phase shift of atan2d(3,-4), or about 143°.

In the Configuration Parameters dialog box, the Fixed-step size
(fundamental sample time) parameter has been set to 1/16*1e-9. This
value is on the order of the wavelength of the carrier. The simulation takes a
total of 81 samples — 16 per cycle.

Compare Passband and Baseband Signals in SimRF
Software
The model

ex_simrf_tut_compare

simulates a 1-GHz sine wave using SimRF blocks. This example builds on
the results of the previous section, “Simulate a Passband Signal in Simulink
Software” on page 1-4.
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1 Introduction to Circuit Envelope Simulation

The system simulates a real passband signal as the real part of a complex
passband signal according to the formula

x t I t jQ t j f t I t f t Q tc c( ) Re ( ) ( ) exp ( )cos ( )sin         2 2  22 f tc 
where:

• I(t) + jQ(t) is the complex-valued modulation, equal to 3 + 4j.

• fc is the angular frequency, equal to 1 GHz.

Contrary to the Simulink passband implementation in the previous section,
the complex baseband signal driving the SimRF system does not include the
carrier. Instead, the SimRF environment handles the carrier analytically.
The carrier appears in four different blocks in the SimRF environment:

• In the Inport block, the Carrier frequencies parameter defines the
carrier frequencies of the modulations entering from outside the SimRF
environment. In this example, there is only one input signal, and only one
carrier (1 GHz, specified as 1e9 Hz).

• In the Outport block, the Carrier frequencies parameter specifies the
signal on the 1e9 Hz carrier (1 GHz) as Simulink signals. These signals
appear at the I and Q ports. The Output parameter is set to Real
Passband, so this signal represents a real passband signal on the 1-GHz
carrier.

• In the block labeled SimRF Outport1 block, also an Outport block, the
Carrier frequencies parameter specifies the signal outputted on the
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1e9 Hz carrier (1 GHz) as Simulink signals. These signals appear at the I
and Q ports. The Output parameter is set to In-phase and Quadrature
Baseband, so these signals represent the in-phase and quadrature
modulations of the signal on the 1-GHz carrier.

• In the Configuration block, the Carrier frequencies parameter specifies
all of the carriers to be modeled in the SimRF circuit-envelope simulation
environment. In this example, only one carrier is specified.

Running the model produces the following output on the scopes.

The Real Passband Scope displays the same output as the example in the
previous section, “Simulate a Passband Signal in Simulink Software” on page
1-4. The signal has a magnitude of 5 and a phase shift consistent with the
specified in-phase and quadrature amplitudes.
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1 Introduction to Circuit Envelope Simulation

The 1-GHz carrier itself does not appear in the output. The results correspond
to the real and imaginary parts of the Complex modulation at the input of the
system. They also correspond to the In-phase modulation and Quadrature
modulation blocks in “Simulate a Passband Signal in Simulink Software”
on page 1-4.

In the Configuration Parameters dialog box, the Fixed-step size
(fundamental sample time) parameter has been set to 1/16*1e-9. This
value is on the order of the wavelength of the carrier. The simulation takes a
total of 81 samples — 16 per cycle.

Simulate the Envelope of a Baseband Signal
The model

ex_simrf_tut_envelope

simulates the envelope of a 1-GHz sine wave using SimRF blocks. This
example builds on the results of the previous section, “Compare Passband and
Baseband Signals in SimRF Software” on page 1-5.

1-8



Minimize Computations for RF Simulations

The system is almost identical to the system in the previous section, except:

• The model contains only one SimRF Outport block and only one scope. The
SimRF environment outputs in-phase and quadrature modulations of the
1-GHz signal. In the SimRF Outport block, the Output parameter is set to
In-phase and quadrature baseband. Since the system is not configured
to output a real passband signal, the carrier is not simulated.

• In the Configuration Parameters dialog box, the Fixed-step size
(fundamental sample time) parameter is greater. Its value is 5e-9
instead of 1/16*1e-9.

Running the model produces the following output at the scope.
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1 Introduction to Circuit Envelope Simulation

The I/Q Scope displays the in-phase and quadrature baseband components of
the 1-GHz signal. The 1-GHz carrier itself does not appear in the output. The
results correspond to the real and imaginary parts of the Complex modulation
at the input of the system.

In contrast to the models in the previous two sections, Simulink works
differently in this model. Because the modulating signals are constant in this
example, only two sample points are needed. To simulate a time-varying
modulating signal, Simulink can use a fixed time step on the order of the
reciprocal of its bandwidth.

The model uses a value of 5e-9 for the Fixed-step size (fundamental
sample time) parameter. This value equals the Stop time because, in
this case, the modulating signals are constant. Compared to the preceding
examples, which use a sample time of 1/16*1e-9, this model simulates
accurately with a time step 80 times larger. This step size results in a
reduction of total sample time by a factor of 80, excluding the initial time
step at time 0.
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Using SimRF Software for the First Time

In this section...

“Expected Background” on page 1-11

“Circuit Envelope, Equivalent Baseband, and Idealized Baseband Library
Features” on page 1-11

“Understanding the SimRF Environment” on page 1-13

Expected Background
Topics in the SimRF documentation assume that you are already familiar
with:

• Using MATLAB® to write and execute scripts and functions.

• Using Simulink to create and simulate block diagrams.

Circuit Envelope, Equivalent Baseband, and Idealized
Baseband Library Features
SimRF software offers Circuit Envelope, Equivalent Baseband, and Idealized
Baseband libraries for modeling RF networks. Each library represents a
distinct simulation paradigm. For certain applications, one library may offer
an advantage over another.

• Use the Circuit Envelope library for multicarrier simulation of RF networks
with arbitrary topologies.

• Use the Equivalent Baseband library for single-carrier simulation of
cascaded RF networks.

• Use the Idealized Baseband library for basic, behavioral simulation of
highly abstracted, Simulink-domain RF devices.

Except for the cross-domain SimRF Inport, SimRF Outport, Input Port, and
Output Port blocks, blocks from the three libraries do not connect to each
other. Therefore, to avoid redesigning your model later, choose which library
to use based on your application. You can consult the following table for a
summary of the features of the three libraries.
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1 Introduction to Circuit Envelope Simulation

(Continued)

Do blocks in
this library...

Circuit
Envelope
Library

Equivalent
Baseband
Library

Idealized
Baseband
Library

Connect directly
to Simulink
blocks?

No, except for
cross-domain
blocks

No, except for
cross-domain
blocks

Yes

Support
single-carrier
simulation?

Yes Yes Yes

Support
multicarrier
simulation?

Yes No No

Support
nonlinear
elements?

Yes Yes Yes

Support
simulation
of cascaded
networks?

Yes Yes Yes

Support
simulation
of networks
with arbitrary
topologies?

Yes No No

Support signal
probing between
input and
output?

Yes No Yes

Support noise
simulation?

Yes Yes No
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(Continued)

Do blocks in
this library...

Circuit
Envelope
Library

Equivalent
Baseband
Library

Idealized
Baseband
Library

Support
Simscape™
platform
features, such
as local solvers?

Yes No No

Support
specification
using network
parameter data?

Yes Yes No

Understanding the SimRF Environment
Groups of interconnected SimRF Circuit Envelope library blocks and the
algorithms that model the RF system that they represent comprise the SimRF
environment. In the SimRF environment, all blocks fall into one of the three
following categories.

Blocks that Operate Within the SimRF Environment
These blocks contribute to the physical representation of an RF system. Most
SimRF Circuit Envelope library blocks fall into this category, including all
blocks in the SimRF Elements and Sources libraries. For example, a Resistor
block can model a source impedance or part of a matching network, and an
Amplifier block could model a physical RF amplifier. Both of these blocks
model physical components.

Blocks within the SimRF environment connect via bidirectional SimRF
signals. SimRF signals are an implementation of Simscape physical signals
whose defined Through and Across variables represent current and voltage,
respectively. For an introduction to Simscape software and physical signals,
see Basic Principles of Modeling Physical Networks.
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1 Introduction to Circuit Envelope Simulation

Blocks that Convert Between the SimRF and Simulink
Environments
These blocks, also called cross-domain blocks, provide an interface from an
RF system to a larger design. SimRF Inport and SimRF Outport blocks fall
into this category. For example, you can construct a signal using blocks from
Communications System Toolbox™ or DSP System Toolbox™ libraries, and
input that signal into the SimRF environment using a SimRF Inport block.

The Configuration block
This blocks manipulates the environment itself. To use this block, connect it to
any part of the RF system. Because it is not part of the physical representation
of the system, it has the same effect regardless of where you connect it.

To run models containing SimRF blocks, you must connect a Configuration
block to the SimRF environment.
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• “Model an RF Mixer” on page 2-2

• “Filter Mixing Products” on page 2-10

• “Measuring Image Rejection Ratio in Receivers” on page 2-16



2 Frequency Conversion

Model an RF Mixer

In this section...

“Build the RF System” on page 2-2

“Define Model Variables” on page 2-4

“Specify Block Parameters for RF Simulation” on page 2-6

“Probe Circuit Envelopes Waveforms” on page 2-8

“Observe Downconverted Envelope Signal at Output Port” on page 2-8

This section of the tutorial shows you how to:

• Use a Sinusoid block to model the envelope of an amplitude-modulated
(AM) waveform.

• Use a Continuous Wave block to model the constant envelope of an ideal
local oscillator (LO).

• Use a Mixer block to downconvert the AM waveform to an intermediate
frequency (IF).

The preceding figure illustrates frequency conversion. A signal modulated on
the carrier fRF mixes with a local oscillator at fLO. The operation downconverts
fRF to fIF = fRF – fLO. The upper mixing product fRF + fLO is not modeled.

Build the RF System
This section shows how to build a SimRF model starting from a blank canvas.
To skip this section and start with the completed model, type
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Model an RF Mixer

ex_simrf_tut_mixer

at the MATLAB Command Window prompt.

This example model specifies an AM waveform at the input port of the mixer,
an LO at the LO port of the mixer, and a 50-Ω termination at the output of a
mixer. To build this model, open the SimRF library by typing simrfV2libs
in the MATLAB Command Window.

Double-click the block labeled Circuit Envelope to open the Circuit Envelope
library.

From the Elements, Sources, and Utilities sublibraries, add the following
blocks to your model.

• From the Elements library, add a Resistor block.

• From the Elements library, add a Mixer block.

• From the Elements library, add a Ground block.

• From the Sources library, add a Continuous Wave block.
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2 Frequency Conversion

• From the Sources library, add a Sinusoid block.

• From the Utilities library, add a Configuration block.

Connect the blocks in the same configuration as the ex_simrf_tut_mixer
model.

Define Model Variables
For models with blocks that share parameter values, specifying parameters
values using variables saves time and effort. To define model variables, use
one of the following workflows.

Use an Initialization Function to Define Variables
Simulink models run MATLAB code stored in the initialization function
(InitFcn) each time the model starts. The MATLAB code runs in the base
workspace. If the initialization function stores variables in the MATLAB
workspace, the variables are overwritten every time the model executes the
initialization function.

Most models in the SimRF User’s Guide use the InitFcn to define model
variables.

1 Open the Model Properties dialog box by selecting File > Model
Properties.

2 In the Callbacks tab, within the Model callbacks pane, select the
InitFcn node.

3 In theModel initialization function pane, enter the following MATLAB
code:

modulationAmplitude = 1;
modulationFrequency = 5e5;
LOAmplitude = 1;
LOFrequency = .95e9;
RFCarrier = 1e9;

For more information, see Using Callback Functions in the Simulink User’s
Guide.
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Model an RF Mixer

Use the Model Explorer to Define Variables
From within the Model Explorer, add variables directly to the model
workspace. Model workspace variables do not interact with the base MATLAB
workspace. The ex_simrf_tut_mixer model uses this approach.

1 Open the Model Explorer window by typing Ctrl + H, by selecting
View > Model Explorer > Current System, or by right-clicking a block
in your model and from the context menu, selecting Explore.

2 On the Model Hierarchy pane, select the Model Workspace node for
your model.

3 On the Contents pane, add the following variables to the workspace by
selecting Add > MATLAB Variable and editing the variable attributes.

Name Value

modulationAmplitude 1

modulationFrequency 500000

LOAmplitude 1

LOFrequency .95e+009

RFCarrier 1e+009

For more information, see The Model Explorer: Overview in the Simulink
User’s Guide.
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2 Frequency Conversion

Use the Command Line to Define Variables
Execute the MATLAB code in this section at the command line to assign
variables directly into a model workspace.

In the Command Prompt window, type:

hmdl = bdroot;
hws = get_param(hmdl,'ModelWorkspace');
hws.assignin('modulationAmplitude',1);
hws.assignin('modulationFrequency',5e5);
hws.assignin('LOFrequency',.95e9);
hws.assignin('LOAmplitude',1);
hws.assignin('RFCarrier',1e9);

For more information on manipulating model workspace data, see Using
Model Workspaces in the Simulink User’s Guide.

Specify Block Parameters for RF Simulation
In this section, you:

• Configure the SimRF environment for multi-frequency circuit-envelope
simulation by specifying the Simulation frequencies parameter in the
Configuration block dialog box.

• Specify the attributes of the waveforms

• Configure global simulation settings.

To specify block parameters, use one of the following workflows.

Using Dialog Boxes to Set Parameters

1 Select Simulation > Model Configuration Parameters to open the
Configuration Parameters dialog box. Specify the following parameters:

• Set Stop time to 1e-5. You can also set the stop time directly on the
Simulink canvas.

• Set Solver to ode23t (mod. stiff/Trapezoidal). The SimRF
environment does not use the ode23t solver. However, since oscillating
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Model an RF Mixer

signals can be stiff, the solver is a good choice for the Simulink
environment when using SimRF blocks.

2 Double-click the Sinusoid block to open the Sinusoid Block Parameters
dialog box. Specify the following parameters:

• Set Sinusoidal amplitude in-phase to modulationAmplitude.

• Set Sinusoidal modulation frequency to modulationFrequency.

• Set Carrier frequencies to RFCarrier.

3 Double-click the Continuous Wave block to open the block dialog box.
Specify the following parameters:

• Set Constant in-phase value to LOAmplitude.

• Set Carrier frequencies to LOFrequency.

4 Double-click the Configuration block to open the block dialog box. Set Step
size to 1e-7.

Using the Command Line to Set Parameters
Execute the MATLAB code in this section at the command line to assign
variables directly into a model workspace.

In the Command Prompt window, type:

hmdl = bdroot;
set_param(hmdl, 'StopTime', '1e-5');
set_param(hmdl, 'Solver', 'ode23t');
set_param([hmdl '/Sinusoid'], ...

'VA_I','modulationAmplitude', ...
'Fmod','modulationFrequency', ...
'CarrierFreq','RFCarrier');

set_param([hmdl '/Continuous Wave'], ...
'IVoltage','LOAmplitude', ...
'CarrierFreq','LOFrequency');

set_param([hmdl '/Configuration'], ...
'StepSize','1e-7');
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2 Frequency Conversion

Probe Circuit Envelopes Waveforms
At the output of the mixer:

• From the SimRF Utilities library, drag and drop an Outport block onto
your model. In the block dialog:

- Set Output to In-phase and quadrature.

- Set Carrier frequencies to RFCarrier - LOFrequency.

• From the Simulink Commonly Used Blocks library, drag and drop a
Scope block and a Terminator block onto your model.

Connect the blocks as shown in the following figure.

This configuration uses a SimRF Outport block as a voltage sensor at the
output port of the mixer. The Simulink signal at the outport is the envelope of
the carrier or carriers specified in the block. A scope attached to the outport
plots the envelope. The Output parameter controls how signals are presented
at the output ports. To change the appearance of the block, follow one of
the workflows in the “Specify Block Parameters for RF Simulation” on page
2-6 section of this tutorial.

Observe Downconverted Envelope Signal at Output
Port
Select Simulation > Run to run the model.

To view the results of the simulation, double-click the scope, and click the
Autoscale button.
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Model an RF Mixer

The Sinusoid specifies a 1-V amplitude for the modulation on fRF, which the
mixer downconverts to fIF. The SimRF Outport block probes the intermediate
frequency and recovers the 1-V modulation amplitude. This value agrees with
a specified conversion gain of 0 dB in the mixer.
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Filter Mixing Products

In this section...

“Probe Multiple RF Carriers” on page 2-11

“Model an RF Filter” on page 2-12

“Simulate Filtering of RF Signals” on page 2-13

“Improve Performance by Reducing Total Simulation Frequencies” on page
2-14

This section of the tutorial shows you how to:

• Configure a SimRF Outport block to probe multiple carrier frequencies
simultaneously.

• Model an analog filter in the SimRF environment using SimRF Capacitor
and Inductor blocks.

The preceding figure illustrates low-pass filtering of a low-side injection
system. Mixing fRF and fLO produces signals on the carriers fIF = fRF – fLO and
fRF + fLO. Adding a low-pass filter to the model reduces the power present
in the high-frequency signal.

To begin, open the model that you created in the “Model an RF Mixer” on
page 2-2 section, or type

ex_simrf_tut_mixer

at the Command Window prompt.
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Probe Multiple RF Carriers
The SimRF environment specifies the carriers fRF – fLO, fRF, fLO, and fRF + fLO,
but the SimRF Outport block probes only the carrier fRF – fLO. Examine
the carriers fRF – fLO and fRF + fLO by changing the model according to the
following workflow:

1 From the Simulink Commonly Used Blocks library, add a Demux block to
your model.

2 In the Scope block dialog box, click the Parameters button, then set
Number of Axes to 2.

3 In the Outport block dialog box, set Carrier frequencies to
[RFCarrier - LOFrequency, RFCarrier + LOFrequency]

4 Connect the blocks as shown in the following figure.

5 Select Simulation > Run to run the model.

To view the results of the simulation, double-click the scope.
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The first set of axes displays the modulation of specified carrier fIF = fRF – fLO.
This carrier appears on the first set of axes because the Carrier frequencies
parameter of the outport specifies it first. The second set of axes displays the
modulation at fRF + fLO. The modulation of the upper mixing product has the
same amplitude as the modulation of the downconverted signal.

Model an RF Filter
To begin, open the model that you created in the “Probe Multiple RF Carriers”
on page 2-11 section, or type

ex_simrf_tut_probe

at the MATLAB Command Window prompt.

1 From the Elements library, drag and drop one Capacitor and two Inductor
blocks onto your model

2 Set the Capacitance parameter of the capacitor to 40e-12 F.

3 Set the Inductance parameter of both inductors to 50e-9 H.

4 Connect the blocks as shown in the following figure.

2-12



Filter Mixing Products

This configuration models a third-order low-pass Butterworth filter with
a cutoff frequency of 1 rad/ns, or about 0.159 GHz. The high-frequency
mixing product is in the stopband of the filter. The low-frequency product
is in the passband.

You can also use an LC Ladder block to model this filter.

Simulate Filtering of RF Signals
To begin, open the model that you created in the previous section, “Model
an RF Filter” on page 2-12, or type

ex_simrf_tut_filter

at the MATLAB Command Window prompt. Select Simulation > Run to
run the model.

To view the results of the simulation, double-click the scope.
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The filter attenuates the high-frequency signal at fRF + fLO and transmits the
signal at fRF – fLO with minimal loss.

The SimRF documentation contains additional RF filter analysis and
simulation examples:

• The example Model an RF Filter Using S-Parameter Data uses an
S-Parameters block to model the filter shown in this tutorial.

• The example “AC Analysis of an RF System” calculates the voltage transfer
function of an RF filter using harmonic balance analysis.

such as

Improve Performance by Reducing Total Simulation
Frequencies
The models in the preceding examples use the Automatically select
fundamental tones and harmonic order setting in the Configuration
block. This setting sacrifices performance for compatibility by guaranteeing
that every specified Carrier Frequency parameter appears in the set of
SimRF simulation frequencies. The performance of the ex_simrf_tut_filter
can be improved by reducing the size of the set of simulation frequencies,
as measured by the Total simulation frequencies value displayed in the
Configuration block dialog.
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To enhance performance of the ex_simrf_tut_filter model, follow the
procedure below.

1 Open and simulate the ex_simrf_tut_filter model.

2 Double-click the Configuration block to open the block dialog box. Note
that the block dialog displays a Total simulation frequencies value of
121. This value indicates that the environment is running 121 separate
simulations.

3 Clear the Automatically select fundamental tones and harmonic
order check box.

4 Set Fundamental tones to [RFCarrier, LOFrequency]. This step is
not strictly necessary, but setting these values clarifies the meaning of
the parameters. Because the mixer has fRF and fLO at its input ports, all
signals at the output of the mixer have carrier frequencies that are linear
combinations of these fundamental tones.

5 Set Harmonic order to 1. The frequencies fRF + fLO and fRF – fLO are the
only output carriers of interest. Modeling signals at a higher harmonic
order than one is not necessary for this system.

6 Click Apply. Note that the block dialog displays a Total simulation
frequencies value of 9.

7 Simulate the model.

The result of the simulation has not changed because every frequency of
importance appears in the new set of simulation frequencies. However,
this procedure reduces overall compatibility. If you make modifications to
the model, such as adding nonlinear amplification, the resulting signals of
interest may not appear in the set of simulation frequencies. You can restore
compatibility by restoring the Automatically select fundamental tones
and harmonic order check box to its default.
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Measuring Image Rejection Ratio in Receivers
This example shows how to use the SimRF™ Circuit Envelope library to
calculate the image rejection ratio (IRR) for high-side-injection in Weaver and
Hartley receivers. The Weaver receiver shows the effect of phase offset on
IRR, and the Hartley receiver shows a similar effect for resistor variation.

model1 = 'simrfV2_hartley';
open_system(model1);

System Architecture

The RF system consists of:

• An Inport block that assigns multiplexed outputs of the RF and Image,
by using Simulink Constant blocks, to the carriers fc_RF and fc_IM
respectively. Real and imaginary values of the Constant blocks are
matched to in-phase and quadrature carrier components.

• First stage mixers that mix the input signal with a local oscillator modeled
by a Continuous Wave block with frequency fc_LO. The LO frequency is
the average of the RF and image frequencies, so both signals are mixed
down to the same frequency, fc_IF. The LO phase is shifted 90 degrees
in one mixer relative to the other.

• The second stage of the Hartley uses a frequency independent RC-CR
network to produce an additional 90 degree phase shift between the two

2-16



Measuring Image Rejection Ratio in Receivers

signal paths, while the Weaver employs two additional mixers for channel
selection.

• A Signal Combiner block that sums the voltage signals at its two inputs
to yield the RF signal. If the Signal Combiner block is used to perform
subtraction, the image can be obtained instead of the RF signal at its
output. For low-side-injection, the Signal Combiner block needs to perform
subtraction.

• The values of the in-phase and quadrature components of the RF and image
signals are chosen to reduce the number of IRR calculations and facilitate
reuse of the Image Rejection Calculator.

Simulating the Hartley Receiver

1 Type open_system('simrfV2_hartley') at the Command Window
prompt.

2 Double-click ’Specify Resistance Range’ and specify a set of resistance
values for the highlighted resistor.

3 Double-click ’Calculate IRR values’ to execute a script,
simrfV2_hartley_callback, that simulates the model once for each
specified resistance value and generates a plot.

The sensitivity of the architecture to the component variation is shown
by simulating the system multiple times, varying the resistance of the
highlighted Resistor block at each iteration. When the highlighted resistor
has a resistance of 1 Ohm, the images sum to zero in the Signal Combiner
block and the IRR is minus infinity.

evalc('simrfV2_hartley_callback');
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bdclose(model1);
model2 = 'simrfV2_weaver';
open_system(model2);
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Simulating the Weaver Receiver

1 Type open_system('simrfV2_weaver') at the Command Window prompt.

2 Double-click ’Specify Phase Offset Values’ and specify a set of phase offset
values.

3 Double-click ’Calculate IRR values’ to execute a script,
simrfV2_weaver_callback, that simulates the model once for each
specified offset and generates a plot.

The sensitivity of the architecture to LO phase offset is shown by simulating
the system multiple times, varying the phase offset of the highlighted Phase
Shift block at each iteration. When the phase offset of the highlighted Phase
Shift block is zero, the images sum to zero in the Signal Combiner block and
the IRR is minus infinity.

evalc('simrfV2_weaver_callback');
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bdclose(model2)
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SimRF Equivalent Baseband Libraries

In this section...

“Overview of SimRF Equivalent Baseband Libraries” on page 3-2

“Open SimRF Equivalent Baseband Libraries” on page 3-3

“Physical Library” on page 3-4

“Mathematical Library” on page 3-6

Overview of SimRF Equivalent Baseband Libraries
The SimRF Equivalent Baseband libraries consist of the Equivalent Baseband
(physical) and Idealized Baseband (mathematical) libraries of components for
modeling RF systems within the Simulink environment. An RF model can
contain blocks from both the physical and mathematical libraries. It can also
include Simulink blocks and blocks from other blocksets.

SimRF Equivalent Baseband software extends your Simulink modeling
environment with a library of blocks for modeling RF systems that include RF
filters, transmission lines, amplifiers, and mixers.

You use SimRF Equivalent Baseband library blocks to represent the
components of your RF system in a Simulink model. The blockset provides
several types of component representations using network parameters (S, Y, Z,
ABCD, H, and T format), mathematical descriptions, and physical properties.

In the Simulink model, you cascade the components to represent your RF
architecture and run the simulation. During the simulation, the model
computes a time-domain, complex-baseband representation. This method
results in fast simulation of the quadrature modeling schemes used in modern
communication systems and enables compatibility with other Simulink blocks.

The blocks let you visualize their specified network parameters using plots
and Smith® Charts.

A validated Simulink model of an RF system can provide an executable
specification for RF circuit design for wireless communication systems.
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You can also use the blockset with Simulink Coder™ software to generate
embeddable C code for real-time execution.

Open SimRF Equivalent Baseband Libraries
To open the main library window, type the following at the MATLAB prompt:

rflib

Each yellow icon in the window represents a library. Double-click an icon to
open the corresponding library.

For a discussion of the Physical and Mathematical libraries, see the following
sections.

Note The blue icons take you to the MATLAB Help browser.

• Double-click the Demos icon to open the SimRF Equivalent Baseband
examples.

• Double-click the Info icon to open the SimRF Equivalent Baseband
documentation.
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Physical Library
Use blocks from the Physical library to model physical and electrical
components by specifying physical properties or by importing measured
data. The Physical library includes several sublibraries, as shown in the
following figure.

The following table describes the sublibraries and how to use them.
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Sublibrary Description

Amplifiers RF amplifiers, specified using
network parameters, noise data,
and nonlinearity data, or a data file
containing these parameters.

Ladder Filters RF filters, specified using LC
parameters. The software calculates
the network parameters and noise
data of the blocks from the topology
of the filter and the LC values.

Series/Shunt RLC Series and shunt RLC components
for designing lumped element
cascades, specified using RLC
parameters. The software calculates
the network parameters and noise
data of the blocks from the topology
of the components and the RLC
values.

Mixers RF mixers that contain local
oscillators, specified using network
parameters, noise data, and
nonlinearity data, or a data file
containing these parameters.

Transmission Lines RF filters, specified using physical
dimensions and electrical
characteristics. The software
calculates the network parameters
and noise data of the blocks from the
specified data.
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Sublibrary Description

Black Box Passive RF components, specified
using network parameters, or a data
file containing these parameters.
The software calculates the network
parameters and noise data of the
blocks from the specified data.

Input/Output Ports Blocks for specifying simulation
information that pertains to all
blocks in a physical subsystem, such
as center frequency and sample time.

Note A physical subsystem is a
collection of one or more physical
blocks bracketed by an Input
Port block and an Output Port
block that bridge the physical and
mathematical parts of the model.

For more information on defining components, see “Specify or Import
Component Data”.

Mathematical Library
The Mathematical library contains mathematical representations of the
amplifier, mixer, and filter blocks. Use a block from the Mathematical library
to model an RF component in terms of mathematical equations that describe
how the block operates on an input signal.

Mathematical blocks assume perfect impedance matching and a nominal
impedance of 1 ohm. This means there is no loading and the power flow is
unidirectional. As such, they are similar to standard Simulink blocks. In
contrast, the physical blocks do not assume perfect matching—these blocks
model the reflections that occur between blocks. Physical blocks model
bidirectional power flow, and include loading effects. For these blocks, you
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can specify the source and load impedances using the Input Port and Output
Port blocks.

The mathematical library is shown in the following figure.
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Equivalent Baseband Workflow
When you analyze an RF system using SimRF Equivalent Baseband software,
your workflow might include the following tasks:

1 Create a Simulink model that includes RF components.

For more information , see “Model RF Components”.

2 Define component data by

• Specifying network parameters, mathematical relationships, or physical
properties

• Importing data from an industry-standard Touchstone file, a
MathWorks™ AMP file, an Agilent® P2D or S2D file, or the MATLAB
workspace

The product lets you access component data in Touchstone SnP, YnP,
ZnP, HnP, and GnP formats. You can also import amplifier network
parameters and power data from a MathWorks AMP file.

For more information, see “Specify or Import Component Data”.

3 Where applicable, add the following information to the component
definition:

• Operating condition values (see “Specify Operating Conditions”).

• Nonlinearity data (see “Model Nonlinearity”).

• Noise data (see “Model Noise”).

4 Validate the behavior of individual blocks by plotting component data.

Note You can plot data for individual blocks from the Physical library that
model physical components either before or after you run a simulation.

For more information, see “Create Plots”.

5 Run the simulation.
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For more information on how the product performs time-domain simulation
of an RF system, see “Simulate an RF Model”.

6 Generate plots to gain insight into system behavior.

For more information, see “Create and Modify Subsystem Plots”.

The following plots and charts are available:

• Rectangular plots

• Polar plots

• Smith Charts

• Composite plots

• Budget plots
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Model an LC Bandpass Filter

In this section...

“Overview of LC Bandpass Filter Example” on page 3-10

“Select Blocks to Represent System Components” on page 3-10

“Build the Model” on page 3-11

“Specify Model Parameters” on page 3-13

“Validate Filter Components and Run the Simulation” on page 3-20

“Analyze the Simulation Results” on page 3-22

Overview of LC Bandpass Filter Example
In this example, you model the signal attenuation caused by an RF filter by
comparing the signals at the input and output of the filter.

The RF filter you use in this example is an LC bandpass filter with a
bandwidth of 200 MHz, centered at 700 MHz. You use a three-tone input
signal to stimulate a range of in-band and out-of-band frequencies of the filter.
The input signal has the following tones:

• 700 MHz — Center of the filter

• 600 MHz — Lower edge of the filter passband

• 900 MHz — Outside the filter passband

You simulate the effects of the filter over a bandwidth of 500 MHz.

Select Blocks to Represent System Components
In this part of the example, you select the blocks to represent the input signal,
the RF filter, and the signal displays.

You model the RF filter using a physical subsystem, which is a collection of
one or more physical blocks bracketed by an Input Port block and an Output
Port block. The RF filter subsystem consists of an LC Bandpass Pi block, and
the Input Port and Output Port blocks. The function of the Input Port and
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Output Port blocks is to bridge the physical part of the model, which uses
bidirectional RF signals, and the rest of the model, which uses unidirectional
Simulink signals.

The following table lists the blocks that represent the system components and
a description of the role of each block.

Block Description

Sine Wave Generates a three-channel signal.

Matrix Sum Combines the three channel signal into a single
three-tone source signal.

Input Port Establishes parameters that are common to all
blocks in the RF filter subsystem, including the
source impedance of the subsystem that is used to
convert Simulink signals to the SimRF Equivalent
Baseband physical modeling environment.

LC Bandpass Pi Models the signal attenuation caused by the RF filter
which, in this example, is the LC Bandpass Pi filter.

Output Port Establishes parameters that are common to all
blocks in the RF filter subsystem. These parameters
include the load impedance of the subsystem, which
is used to convert RF signals to Simulink signals.

Spectrum Scope Displays signals at the input to and output of the
filter.

Build the Model
In this part of the example, you create a Simulink model, add blocks to the
model, and connect the blocks.

1 Create a model with the blocks shown in the following table. The Library
column of the table specifies the hierarchical path to each block.
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Block Library Path Quantity

Sine Wave DSP System Toolbox > Sources 1

Matrix Sum DSP System Toolbox > Math
Functions > Matrices and Linear
Algebra > Matrix Operations

1

Spectrum Scope DSP System Toolbox > Sinks 2

Input Port SimRF > Equivalent Baseband > Equivalent
Baseband > Input/Output Ports

1

LC Bandpass Pi SimRF > Equivalent Baseband > Ladder Filters 1

Output Port SimRF > Equivalent Baseband > Input/Output
Ports

1

2 Connect the blocks as shown in the following figure.

For more information on connecting physical and mathematical blocks,
see “Connect Model Blocks”.

Now you are ready to specify block parameters.
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Specify Model Parameters
In this part of the example, you specify the following parameters to represent
the behavior of the system components:

• “Input Signal Parameters” on page 3-13

• “Filter Subsystem Parameters” on page 3-15

• “Signal Display Parameters” on page 3-19

Input Signal Parameters
You generate the three-tone source signal using two blocks. You use the Sine
Wave block to generate a complex three-channel signal, where each channel
corresponds to a different frequency. Then, you use the Matrix Sum block to
combine the channels into a single three-tone source signal. Without this
block, the signal in all subsequent blocks would have three independent
channels.

The SimRF Equivalent Baseband simulation algorithm requires you to
shift the frequencies of the input signal. The software simulates the
filter subsystem using a complex-baseband modeling technique, which
automatically shifts the filter response and centers it at zero. You must shift
the frequencies of the signals outside the physical subsystem by the same
amount.

For more information on complex-baseband modeling, see “Create a Complex
Baseband-Equivalent Model”.

Note All signals in the RF model must be complex to match the signals in
the physical subsystem, so you create a complex input signal.

The center frequency of the LC bandpass filter is 700 MHz, so you use a
three-tone source signal with tones that are 700 MHz below the actual tones,
at -100 MHz, 0 MHz, and 200 MHz, respectively.

1 In Sine Wave block dialog box:

• Set the Amplitude parameter to 1e-6.
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• Set the Frequency (Hz) parameter to [-100 0 200]*1e6.

• Set the Output complexity parameter to Complex.

• Set the Sample time parameter to 1/500e6.

• Set the Samples per frame parameter to 128 .

2 In the Matrix Sum block dialog box:

• Set the Sum over parameter to Specified dimension.

• Set the Dimension parameter to 2.
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Filter Subsystem Parameters
In this part of the example, you configure the blocks that model the RF filter
subsystem—the Input Port, LC Bandpass Pi, and Output Port blocks.

1 Set the Input Port block parameters as follows:

• Treat input Simulink signal as = Incident power wave

This option tells the blockset to interpret the input signal as the incident
power wave to the RF subsystem, and not the source voltage of the RF
subsystem.
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Note If you use the default value for this parameter, the software
interprets the input Simulink signal as the source voltage. As a result,
the source and the load that model the Input Port and Output Port
blocks, respectively, introduce 6 dB of loss into the physical system at
all frequencies. For more information on why this loss occurs, see the
note in “Convert to and from Simulink Signals”.

• Center frequency = 700e6

• Sample time (s) = 1/500e6

• Clear the Add noise check box so the software does not include noise in
the simulation. To learn how to model noise, see “Model Noise”.
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Note You must enter the Sample time (s) because the Input Port block
does not inherit a sample time from the input signal. The specified sample
time must match the sample time of the input signal. The Sample time
(s) of 1/500e6 second used in this example is equivalent to a bandwidth
of 500 MHz.

2 Accept default parameters for inductance and capacitance in the LC
Bandpass Pi block. These parameters create a filter with the desired
bandwidth of 200 MHz, centered at 700 MHz.

3 Accept the default parameters for the Output Port block to use a load
impedance of 50 ohms.
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Signal Display Parameters
In this part of the example, you specify:

• The parameters of the Spectrum Scope block to display the source signal

• The parameters of the Spectrum Scope1 block to display the filtered signal

For each scope, you set the range of the x- and y-axes to make sure that the
entire signal is visible.

By default, the scope displays appear stacked on top of each other on the
screen when you run the simulation, so you can only see one of them. To
ensure that both scopes are visible during the simulation, you specify a
different position for each scope on the screen.

1 In the Spectrum Scope block dialog box:

• In the Scope Properties tab, set the Spectrum units parameter to
dBm.

• In the Display Properties tab, set the Scope position parameter to
get(0,'defaultfigureposition').*[.15 1 1 1]

• In the Axis Properties tab, set the Minimum Y-limit parameter to
-220.
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• In the Axis Properties tab, set theMaximum Y-limit parameter to -80

• In the Axis Properties tab, set the Y-axis label parameter to dBm.

2 Set the Spectrum Scope1 block parameters as follows:

• In the Scope Properties tab, set the Spectrum units parameter to
dBm.

• In the Display Properties tab, set the Scope position parameter to
get(0,'defaultfigureposition').*[1.85 1 1 1]

• In the Axis Properties tab, set the Minimum Y-limit parameter to
-220.

• In the Axis Properties tab, set theMaximum Y-limit parameter to -80

• In the Axis Properties tab, set the Y-axis label parameter to dBm.

Note If you do not specify the position of the scopes using the Display
Properties tab, you can click and drag the displays to arrange them on the
screen after the simulation starts.

Validate Filter Components and Run the Simulation
In this part of the example, you validate the behavior of the LC Bandpass Pi
filter block by plotting its frequency response and then run the simulation.

Note When you plot information about a physical block, the plot displays
the actual frequency response of the block at the selected passband (i.e.,
the response at the unshifted frequencies), not the response at the shifted
frequencies. For more information on this shift, see “Input Signal Parameters”
on page 3-13.

1 Double-click the LC Bandpass Pi block to open the block dialog box.

2 Select the Visualization tab and click Plot to plot the frequency response
of the filter. This plots the magnitude of S21 as a function of frequency,
which represents the gain of the filter.
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Filter Gain

Note The physical blocks only model a band of frequencies around the
center frequency of the physical subsystem. You must choose the sample
time and center frequency such that all important frequency characteristics
of your physical subsystem fall in this band of frequencies. The plot shows
the frequency response of the filter for the portion of the RF spectrum that
the physical blocks model. In this example, the physical blocks model a
500-MHz band centered at 700 MHz, as defined by the Input Port block.

3 In the model window, select Simulation > Start to run the simulation.

3-21



3 Introduction to Equivalent Baseband Simulation

Analyze the Simulation Results
In this part of the example, you analyze the results of the simulation. This
section contains the following topics:

• “Compare the Input and Output Signals of the RF Filter” on page 3-22

• “Plot Model Parameters of the Filter Subsystem” on page 3-24

Compare the Input and Output Signals of the RF Filter
You can view the source signal and the filtered signal in the Spectrum Scope
windows while the model is running. These windows appear automatically
when you start the simulation.

The Spectrum Scope blocks display the signals at the shifted
(baseband-equivalent) frequencies, not at the selected passband frequencies.
You can relabel the x-axes of the Spectrum Scope windows to display the
passband signal by entering the Center frequency parameter value of
700e6 (from the Input Port block) for the Frequency display offset (Hz)
parameter in the Axis Properties tab of the Spectrum Scope block dialog
boxes. For more information on complex-baseband modeling, see “Create a
Complex Baseband-Equivalent Model”.

The Spectrum Scope blocks display power spectral density normalized to unit
sampling frequency. To display power per channel, insert a Gain block with
the Gain parameter set to 1/sqrt(N) before each Spectrum Scope block. N is
the number of channels. The Gain block is in the Simulink > Commonly
Used Blocks library.

In this example, N is 128 (the value of the Samples per frame parameter of
the Sine Wave block, 128).

Note SimRF Equivalent Baseband signals represent amplitudes, not
voltages. This means that in the product, power is defined as:

Power inwatts Amplitude involts sqrt ohm( ) ( / ( ))=[ ]2

3-22



Model an LC Bandpass Filter

The following plot shows the RF filter input signal you specified in the Sine
Wave block.

Input to RF Filter

The next plot shows the filtered signal. Notice the RF filter does not attenuate
the signal at the center frequency.
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Attenuated Output of RF Filter

Plot Model Parameters of the Filter Subsystem
After you simulate an RF model, you can evaluate the behavior of the physical
subsystem by plotting the network parameters of the Output Port block.

Note When you plot information about a physical subsystem, the plot
displays the actual frequency response of the subsystem at the selected
passband (i.e. the response at the unshifted frequencies), not the response at
the shifted frequencies.

To understand the frequency response of the filter, examine the S-parameters
as a function of frequency for the RF filter subsystem on a composite plot.

1 Open the dialog box of the Output Port block by double-clicking the block.

2 Select the Visualization tab, and click Plot.
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The composite plot, shown in the following figure, contains four separate
plots in one figure. For the Output Port block, the composite plot shows the
following as a function of frequency (counterclockwise from the upper-left
plot):

• An X-Y plane plot of the magnitude of the filter gain, S21, in decibels.

• An X-Y plane plot of the phase of the filter gain, S21, in degrees.

• A Z Smith chart showing the real and imaginary parts of the filter
reflection coefficient, S11.

• A Polar plane plot showing the magnitude and phase of the filter reflection
coefficient, S11.

Note In this example, the response of the filter subsystem is the same as the
response of the filter block because the subsystem contains only a filter block.
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